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Introduction 
Ce tutoriel détaille pas à pas l’utilisation du plug in Semi-Automatic Classification Plugin (SCP), 
développé par Luca Congedo sur Qgis ®, dans l’objectif de classifier des zones de châtaigneraies 
en fonction de leur état de dépérissement.  

Ce tutoriel s’inscrit dans le cadre du stage sur l’évaluation du dépérissement de la châtaigneraie 
du Vallespir, qui a été financé par la Région Occitanie au travers du Défi-Clé O3T et co-encadré 
par le CIHEAM (Centre International des Hautes Etudes Agronomiques Méditerranéennes) de 
Montpellier et le Pays Pyrénées Méditerranée. 

Ce tutoriel s’adresse aux acteurs du territoire déjà formés à l’utilisation de Qgis ® et qui ne 
connaissent pas les outils de télédétection. Cependant, chaque étape est suffisamment détaillée 
pour le rendre accessible à tout utilisateur novice. 

Il a été nécessaire de récolter des données de terrain afin de pouvoir calibrer le modèle. Les 
châtaigneraies ont été observées et notées à l’aide de la méthode DEPERIS. Ces données ont 
servi de calibration pour la classification par méthode supervisée.  

Trois classes de dépérissement des arbres ont été définies : 

- Faiblement dépérissant (de 0 à 50 % de dépérissement) 
- Moyennement dépérissant (de 50 à 75 % de dépérissement) 
- Fortement dépérissant (de 75 à 100 % de dépérissement) 

Pour plus de renseignements ou pour répondre à un questionnement vous pouvez contacter 
l’animatrice de la Charte Forestière de Territoire du Pays Pyrénées Méditerranée sur le mail 
suivant : cft@payspyreneesmediterranee.org.  

 

Schéma simplifié des étapes de réalisation pour la télédétection  

mailto:cft@payspyreneesmediterranee.org
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Résumé des étapes  :  

1) Téléchargement des données dans le Plug-In SCP de Qgis ® 
o Sélectionner des tuiles aux dates estivales (durant la feuillaison) 
o Sélectionner des tuiles avec un faible taux d’ennuagement (-de 10 %) 
o Sélectionner des tuiles avec un traitement atmosphérique L2A 
o Sélectionner les bandes spectrales nécessaires pour le calcul des indices  

2) Traitement des tuiles téléchargées 
o Fusionner les tuiles si nécessaires (ici par exemple deux tuiles (T31TDG et T31TDH) 

sont nécessaires pour représenter le territoire) 
o Exporter les bandes et changer le SCR : toujours en Lambert 93 
o Masquer les bandes spectrales avec la BD forêt châtaignier  

3) Calculs des indices de télédétection 
o Utiliser la calculatrice raster pour entrer les formules de calculs sur les indices  
o Masquer les résultats avec la couche BD Forêt châtaignier  

4) Classification supervisée et sélection des zones  
o Créer des classes dans un fichier d’entraînement et enregistrer ce fichier  
o Utiliser l’outil « create a ROI polygone » depuis le plug in SCP pour sélectionner les 

zones selon les classes « faiblement dépérissant à très dépérissant » à partir des 
points GPS disposés sur la carte (données terrains, qui seront les données 
d’entrainement) 

o Enregistrer chaque polygones classe par classe (au moins 3 polygones par classe) 
o Une fois les classes réalisées, utiliser l’outil classification dans l’onglet traitement 

de bande 
o L’algorithme permettant de classifier au mieux est « au plus proche voisin » 

utilisant les distances euclidiennes et ayant montré de bons résultats  

 

1) Données à télécharger  
Rappel pour télécharger Qgis : 

Se rendre sur le site : https://qgis.org/download/ et télécharger la version LTR (Long Term Version) 
soit actuellement la version 3.40 

a-Téléchargement du « Semi-Automatic Classification Plugin » 

Dans un premier temps, il faut télécharger le plug in « Semi-Automatic Classification Plugin » 
(SCP) dans Extensions > Installer/Gérer les extensions.  

 

https://qgis.org/download/
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Sélectionnez « Semi-Automatic Classification Plugin » et cliquez sur « Installer l’extension ». 

 

 

b-Téléchargement des tuiles  
Si vous n’avez pas encore de fonds de carte, vous pouvez récupérer celui d’OpenStreetMap en 
sélectionnant dans l’Explorateur dans « Tuiles XYZ > OpenStreetMap ». 

Rendez-vous ensuite dans l’onglet SCP de Qgis ® et ouvrez la fenêtre. 

 

Une fois la fenêtre ouverte, cliquez sur l’onglet « Télécharger des produits ».  
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Dans l’onglet « Télécharger des produits », il y a une barre de recherche permettant de 
sélectionner :  

- une échelle de temps (1) 
- la couverture nuageuse (2) 
- En bas de la page, il est possible de sélectionner les bandes spectrales d’intérêt, il suffit 

de cocher/décocher les bandes qui nous intéresse.  
- Ensuite il faut sélectionner (3) la zone d’étude directement sur la carte avec le bouton + 

qui permet, en faisant des clics droits, de sélectionner la zone exacte de l’étude.  

 

 

 

 

 

1 
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Il faut veiller à sélectionner les tuiles permettant de visualiser au mieux les informations : 

1) Sélectionnez des tuiles aux dates estivales 
(durant la feuillaison) 
2) Sélectionnez des tuiles avec un faible taux 
d’ennuagement (-de 10 %) 
3) Sélectionnez le territoire : -cliquez sur le 
bouton + qui permettra de sélectionner l’emprise 
sur le fond cartographique (pour cela, retournez 
sur le fond cartographique QGIS et sélectionnez la 
zone d’étude avec clic gauche pour l’extrémité 
nord-ouest de l’emprise et clic droit pour 
l’extrémité sud est) puis -cliquez sur le bouton 
« Chercher ». Deux tuiles sont nécessaires pour 

représenter l’ensemble du Vallespir (attention à choisir de préférence des tuiles à des 
dates similaires) 

4) Sélectionnez des tuiles avec un traitement atmosphérique L2A dans la liste de produits 
avec ctrl+clic gauche. Exemple de sélection de deux tuiles dans la Liste de Produits :

 

5) Prévisualisez les tuiles en cliquant sur et choisissez deux tuiles qui ne présentent 
pas de défauts pouvant empêcher l’extraction des résultats (nuages sur une zone de 
châtaignier, image défectueuse ou partie manquante).  

6) Sélectionnez ces deux tuiles dans la liste de produits avec clic gauche +ctrl puis les 
bandes spectrales nécessaires pour le calcul des indices (bandes 2,3,4,5,6,7,8,11,12 et 
Données auxiliaires), cochez « Charger les bandes dans QGIS » et cliquez sur « Lancer ».  

2 

3 

3 
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La liste des produits devrait être composé du traitement L2A suivi du numéro de la tuile, du code 
de l’image et de la date à laquelle la tuile a été récupérée. 

Les tuiles doivent être chargées bande par bande sous format Raster dans Qgis ®. Les bandes 
spectrales B2, B3, B4, B5, B6, B7, B8, B8A, B11, B12 seront utilisées pour calculer des indices de 
télédétection, afin de mettre en avant la végétation, l’humidité et d’autres facteurs. Les valeurs 
de réflectances sont liées à des bandes qui possèdent chacune des longueurs d’ondes 
spécifiques (Annexe 1).  

c- Téléchargement de la BD Forêt V2 Châtaignier 
Pour la suite, nous aurons besoin de la couche « Châtaignier » de la BD Forêt V2 de l’IGN.  

Si vous avez déjà la couche « Châtaignier » de la BD Forêt V2 sur votre territoire, alors allez 
directement à l’étape 2) Traitement des tuiles… page 12. 

Si vous ne l’avez pas encore, vous pouvez aller la télécharger sur : 
https://geoservices.ign.fr/bdforet  

Une fois les données téléchargées, dans le dossier ….BDFORET>1_DONNES_LIVRAISON , 
importez la couche « FORMATION_VEGTALE.shp ». 

Sélectionnez cette couche et cliquez sur  « Sélectionner des entités par valeur… » 

4 

5 

6 

https://geoservices.ign.fr/bdforet


 

9 
 

« Projet soutenu par la Région Occitanie dans le cadre du Défi Clé Observation de la Terre et 
territoires en Transition – O3T. » 

 

Une fenêtre s’ouvre, dans le champ « Essence », sélectionnez « Châtaignier » et cliquez sur 
« Sélection des entités ».

 

Ensuite, exportez ces entités en cliquant sur la couche 
« FORMATION_VEGETALE »>Exporter>Sauvegardez les entités sélectionnées sous… 

Vous pouvez alors nommer votre nouvelle couche « BDFORETV2_Chataignier » 
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Si vous souhaitez ensuite reistreidre la couche Châtaignier ainsi créée au périmètre de votre 
territoire, vous pouvez cliquer sur « Sélection par localisation » 

 

Dans « Sélectionnez les entités depuis » choississez votre couche nouvellement créée (ici 
BDFORETV2_CHATAIGNIER) et dans « En comparant les entités de », sélectionnez votre 
territoire d’études (ici la couche PPM2013_communes). 
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En registrez la couche ainsi créée avec : clic droit sur le nom de la couche>Exporter> 
Sauvegarder les entités sélectionnées sous…

 

Vous obtenez ainsi la couche comprenant toutes les chataigneraies de votre territoire d’étude. 
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2) Traitements des tuiles téléchargées  
Lorsque la zone d’étude est située à cheval entre 
plusieurs tuiles (ou images satellites), il est 
nécessaire de les fusionner (ici par exemple deux 
tuiles sont nécessaires pour représenter le 
territoire).  

 

  

 

 

Pour fusionner les tuiles, cliquez sur Raster > Miscellaneous>Fusion… Une fois la fenêtre ouverte, 

dans « Couches en entrée » cliquez sur  . 

  

Ensuite, sélectionnez les couches en entrée puis cliquez sur « Exécuter ».  

T31TDG  

T31TDH  
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Exportez les couches raster des bandes spectrales et changer le SCR : EPSG: 2154 – RGF93 v1 / 
Lambert-93 (veillez à ce que l’ensemble des couches soient au même SCR et en Lambert 93).  

Pour cela, cliquez droit sur la couche « Fusionné » puis sur Exporter>Enregister sous… Choisir le 
nom de cette nouvelle couche, l’emplacement où sera enregistré la couche raster en cliquant sur 

, choisir le SCR (EPSG: 2154 – RGF93 v1 / Lambert-93 ) et cliquez sur OK.

 

Répétez l’opération pour toutes les bandes. 

 

Ensuite, il faut découper les couches Raster selon une couche masque en vecteur (notre couche 
châtaignier de BD forêt). Remarque : parfois la couche BD Forêt Châtaignier comporte des 
erreurs, il faudra ainsi « vérifier la validité » de la couche depuis les outils de géométrie, depuis 
l’onglet Vecteur>Geometry Tools>Vérifier la validité.  

Dans Raster>Extraction>Découper un raster selon une couche de masque… sélectionnez en 
couche source la couche fusionnée (ici B08A_fusion) et en couche de masquage la couche 
Châtaignier de BD Forêt.  
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Les résultats sont représentés ci-dessous. 
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Les résultats sont ensuite enregistrés dans 
un fichier Raster éphémère qu’il convient 
d’exporter, toujours en Lambert 93.  

Répéter l’opération pour l’ensemble des 
bandes spectrales.  

Par la suite, il faut calculer l’ensemble des 
indices de télédétection (voir la liste et les 
formules en annexe 2). 

 

 

3) Calcul des indices de télédétection 
Dans l’outil « calculatrice raster », il faut entrer les formules spécifiques de chaque indice de 
télédétection.  

 

Si l’on veut calculer le DVI par exemple, il suffit de diviser les couches raster entres elles, on peut 
cliquer depuis le panneau de droite « bandes raster » pour sélectionner la bande 8 et la bande 4 
(qui ont été au préalable masquées avec la couche châtaignier de BD Forêt), puis en dessous 
sélectionner « / » pour diviser les bandes entres elles.  

Dans le panneau de droite « Couche résultat » choisir le nom de de la couche en sortie (ici DVI), le 

dossier cible en cliquant sur , laisser en format en sortie « GeoTIFF » et exporter la couche 
en cliquant sur « OK ».  
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L’indice DVI doit donner une résolution spectrale de 10 m, soit représenter un carré au sol de 10 
m par 10 m. Nous obtenons les résultats ci-dessous : 
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4) Classification supervisée et sélection des zones 
Il faut ensuite ajouter à votre projet les données de calibrations (ici « arbre_scoring.. »), c’est-à-
dire les zones de terrains identifiées de faiblement dépérissantes à fortement dépérissantes. 
Comme ci-dessous, où les arbres ont été notées sur des placettes situées autour de Corsavy.  

 

 

Cliquer sur  , la fenêtre « Semi-Automatic Classification Plugin » s’ouvrira mais il faut la 
fermer et aller dans l’onglet SCP Dock puis cliquez sur « Entrée données d’entrainement ». 

 

Créer la couche qui recevra les données d’entrainement en  cliquant sur «Create a new training 
input », choisir le nom du fichier, son emplacement et cliquer sur « Enregistrer ».  
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Pour chaque classe, il sera nécessaire de renseigner un nom, un numéro de macro classe (MC ID) 
et un numéro de classe (C ID) (1).  

Pour calibrer chaque classe, sur l’interface SCP Dock,  sélectionnez l’outil « Create a ROI 
polygone » (2), sélectionner au minimum 3 zones de calibration par classe. Veiller à bien changer 
de classe après avoir créé les polygones de chaque classe et les avoir enregistrés avec la 
disquette en bas à droite (3).  

A noter : il faut sélectionner « Create a ROI polygone », puis appuyer sur clic gauche pour le créer 
et clic droit pour le fermer.  

 

 

 

 

1 

2 

2 
3 

1 
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Lorsque que vous avez créé au moins 3 polygones par classe, vous devez cliquer sur « Fusionner 
les signatures spectrales surlignées » pour obtenir une signature spectrale moyenne par classe. 

 

Une fois tous les polygones créés pour chaque classe, cela fait 3 classes : faiblement dépérissant, 
moyennement dépérissant, très dépérissant. 

 

 

 

 

 

 

 

 

 

 

 

Il est possible d’observer les signatures spectrales de chaque classe. Il faut au préalable 
sélectionner l’ensemble des classes et cliquer sur l’onglet « add hilighted signatures …» 
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Dans l’onglet « SCP », cliquez sur « Jeu de bandes » et sélectionnez les indices de télédétection 
dans un même jeu de bande. 
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Toujours dans l’onglet « SCP », choisissez « Traitement de bande » puis « Classification » pour 
classifier le modèle selon les macroclasses.  

Sélectionnez l’algorithme « Plus proche voisin » qui permet de calculer à partir des distances 
euclidiennes les correspondances des pixels entres eux.  

 Veiller à bien sélectionner le jeu de bande correspondant aux indices préalablement calculés.  

 

Pour finir, cliquez sur « Lancer », une fenêtre d’export s’ouvre, puis une fenêtre de chargement :  

 

Il faut ensuite masquer la couche de classification avec la couche Châtaignier de BD Forêt, puis 
exporter le raster final de classification. 
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Vous devriez obtenir une couche comme celle-ci : 

 

5) Pour finir  
Une fois les résultats obtenus il faut faire attention à l’interprétation et garder à l’esprit que c’est 
un exercice qui peut comporter des biais importants.  

Ici par exemple, toutes les zones apparaissant comme « Faiblement dépérissants » sont des 
zones possédant une signature spectrale proche de celle de nos placettes de calibrations qui 
comportaient entre 0 et 50 % d’individus notés dépérissants sur le terrain (soit classés D,E ou F 
avec la notation DEPERIS).  De même pour la classe « Moyennement dépérissant », les zones 
apparaissant en orange possèdent une signature spectrale proche des placettes de calibration 
sur lesquels 50 à 75% des arbres ont été notés comme dépérissants selon DEPERIS.  Les zones 
« Fortement dépérissant » sont similaires aux placettes de calibration sur lesquelles plus de 75% 
des arbres étaient notés dépérissants sur le terrain. 

Ainsi, plus une classe possèdera de placettes de calibrations, meilleure sera l’exactitude du 
classement final. 

Il est également possible de comparer les données en créant plusieurs cartes sur plusieurs 
périodes (début de l’été/fin de l’été) ou sur plusieurs années (période estivale 2020 par rapport à 
2025) par exemple.  

Il serait intéressant de réaliser une matrice de confusion sur des données de validation. Les 
données de validation s’obtiennent en allant sur le terrain et en récupérant données par données 
l’ensemble des informations. La matrice de confusion est un tableau permettant de connaître les 
pixels bien classifiés par rapport aux pixels classifiés d’une autre catégorie.  

Ici par exemple, le tableau ci-dessous montre dans la diagonale verte les pixels qui ont été bien 
classifiés.  
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ANNEXES 

Annexe 1 : Bandes spectrales de Sentinel – 2 MSI 
Bandes spectrales de Sentinel – 2 MSI, leur longueur d’ondes (nm) et leur résolution spatiale en 
(m) (Frampton et al., 2013), en encadré vert = les bandes utilisées 

 

Annexe 2 : Formules de calcul des indices de télédétection 
Les indices suivants sont tirés des indices utilisés dans le projet Casteldiag du SPNA. Ici, Bxx 
correspond à une bande spectrale et xx au numéro de la bande spectrale.  

1) 𝑁𝐷𝑉𝐼 =  
𝐵08−𝐵04

𝐵08+𝐵04
 = normalized difference vegetation index 

2) 𝑁𝐷𝐼𝐼 =  
𝐵08−𝐵11

𝐵08+𝐵11
 = normalized difference index, in a reflectance measurement, sensitive 

to changes in water content of plant canopies 
 

3) 𝑁𝐷𝑊𝐼 =  
𝐵03−𝐵08

𝐵03+𝐵08
  = normalized difference water index 

4) 𝑁𝐵𝑅 =  
𝐵08−𝐵12

𝐵08+𝐵12
 = normalized burnt ratio 

5) 𝑁𝐷𝑉𝐼𝑟𝑒2𝑛 =  
𝐵08𝐴−𝐵06

𝐵08𝐴+𝐵06
 = normalized difference vegetation index red-edge 2 narrow 

6) 𝐷𝑉𝐼 =  
𝐵08

𝐵04
 = difference vegetation index 

7) 𝐶𝑖𝑔𝑟𝑒𝑒𝑛 =  
𝐵08

𝐵03
− 1 = chlorophylle index 

8) 𝐶𝑟𝑖2 =  
1

𝐵02
−

1

𝐵05
 = carotenoïdes reflectance index 

9) 𝐺𝑁𝐷𝑉𝐼 =  
𝐵08−𝐵03

𝐵08+𝐵03
 = green normalized difference vegetation index  

10) 𝑆2𝑟𝑒𝑝 = 705 + 35 ∗ ((
( 

(𝐵07+𝐵04)

2
)−𝐵05)

(𝐵06−𝐵05)
) = Sentinel-2 Red-Edge Position Index 
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Bibliographie et liens utiles  
https://tutoqgis.cnrs.fr/12_00_teledetection.php : tutoriel de télédétection depuis le site 
internet de Qgis®  

https://www.youtube.com/watch?v=ecL2hlbC8vw : vidéo de classification par méthode 
supervisée 

Pour utiliser les flux WMS/WMTS  

- https://data.geopf.fr/wms-r/wms?VERSION=1.3.0 : WMS Raster 

- https://data.geopf.fr/wms-v/wms?VERSION=1.3.0 : WMS Vecteur  

- https://data.geopf.fr/wmts?SERVICE=WMTS&VERSION=1.0.0&REQUEST=GetCapabilitie
s : Serveur WMTS  

- https://geodata.inrae.fr/geoserver/inra_bdgsf/wms : Réserve Utile en eau et carte des 
sols BDGSF 

- https://mapserver.openig.org/maps/openig : OpenIG (occupation au sol…) 

 

https://tutoqgis.cnrs.fr/12_00_teledetection.php
https://www.youtube.com/watch?v=ecL2hlbC8vw
https://data.geopf.fr/wms-r/wms?VERSION=1.3.0
https://data.geopf.fr/wms-v/wms?VERSION=1.3.0
https://data.geopf.fr/wmts?SERVICE=WMTS&VERSION=1.0.0&REQUEST=GetCapabilities
https://data.geopf.fr/wmts?SERVICE=WMTS&VERSION=1.0.0&REQUEST=GetCapabilities
https://geodata.inrae.fr/geoserver/inra_bdgsf/wms
https://mapserver.openig.org/maps/openig

